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WARNING 
Some of the circuitry inside this system operates at hazardous energy and 
electric shock voltage levels. To avoid the risk of personal injury due to 
contact with an energy hazard, or risk of electric shock, do not enter any 
portion of this system unless it is intended to be accessible without the use 
of a tool. The areas that are considered accessible are the outer enclosure 
and the area just inside the front door when all of the front panels are in
stalled, and the front of the diagnostic station. There are no user service
able areas inside the system. Refer any need for such access only to tech
nical personnel that have been qualified by Intel Corporation. 

CAUTION 
This equipment has been tested and found to comply with the limits for a 
Class A digital device, pursuant to Part 15 of the FCC Rules. These limits 
are designed to provide reasonable protection against harmful interfer
ence when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, 
if not installed and used in accordance with the instruction manual, may 
cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in 
which case the user will be required to correct the interference at his own 
expense. 

LIMITED RIGHTS 
The information contained in this document is copyrighted by and shall re
main the property of Intel Corporation. Use, duplication or disclosure by 
the U.S. Government is subject to Limited Rights as set forth in subpara
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clause at 252.227-7013. Intel Corporation, 2200 Mission College Boule
vard, Santa Clara, CA 95052. For all Federal use or contracts other than 
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Preface 

This manual describes the System Performance Visualization tool (SPV). The manual is intended 
for Paragon TM system users who wish to monitor the performance of their Paragon system. The 
sections of this manual that describe the X resources used to configure SPY assume familiarity with 
X resources. 

For window displays, menus, commands, buttons, keyboard accelerators, and dialog boxes, SPY 
follows the Motif style guide. This manual assumes the Motif window manager functionality. SPY 
can, however, be run under window managers other than the Motif window manager. 

Organization 
Chapter 1 

Chapter 2 

Chapter 3 

Appendix A 

Provides an overview of SPY, describes how to start SPY, and describes Spy 
error conditions. 

Describes SPV's windows, menus, and commands. 

Describes the X resources used to configure SPY. 

Describes the default configuration for SPY. 

Notational Conventions 
This manual uses the following notational conventions: 

Bold Identifies command names and switches, system call names, reserved words, 
and other items that must be used exactly as shown. 

v 
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Italic 

Paragon™ System Performance Visualization Tool User's Guide 

Identifies variables, filenames, directories, processes, user names, and writer 
annotations in examples. Italic type style is also occasionally used to 
emphasize a word or phrase. 

Plain-Monospace 
Identifies computer output (prompts and messages), examples, and values of 
variables. Some examples contain annotations that describe specific parts of 
the example. These annotations (which are not part of the example code or 
session) appear in italic type style and flush with the right margin. 

Bold-Italic-Monospace 
Identifies user input (what you enter in response to some prompt). 

Bold-Monospace 

} 

Identifies the names of keyboard keys (which are also enclosed in angle 
brackets). A dash indicates that the key preceding the dash is to be held down 
while the key following the dash is pressed. For example: 

<Break> <s> <ctrl-Alt-Del> 

(Brackets) Surround optional items. 

(Ellipsis dots) Indicate that the preceding item may be repeated. 

(Bar) Separates two or more items of which you may select only one. 

(Braces) Surround two or more items of which you must select one. 

Applicable Documents 

vi 

For more information about Paragon system documents, refer to the Paragon™ System Technical 
Documentation Guide. 
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Comments and Assistance 
Intel Scalable Systems Division is eager to hear of your experiences with our products. Please call 
us if you need assistance, have questions, or otherwise want to comment on your Paragon system. 

U.S.A.lCanada Intel Corporation 
Phone: 800-421-2823 

Internet: support@ssd.intel.com 

Intel Corporation Italia s.p.a • 
Milanofiori Palazzo 

United Kingdom Intel Corporation (UK) Ltd. 
Scalable Systems Division 

20090 Assago 
Milano 
Italy 
167877203 (toll free) 

France Intel Corporation 
1 Rue Edison-BP303 

Pipers Way 
Swindon SN3 IRJ 
England 
0800212665 (toll free) 
(44) 793 491056 
(44) 793 431062 

78054 St. Quentin-en-Yvelines Cedex 
France 

(44) 793 480874 
(44) 793 495108 

05908602 (toll free) 

Intel Japan K.K. 
Scalable Systems Division 
5-6 Tokodai, Tsukuba City 
Ibaraki-Ken 300-26 
Japan 
0298-47-8904 

Germany Intel Semiconductor GmbH 
Dornacher Strasse 1 
85622 Feldkirchen bei Muenchen 
Germany 
0130813741 (toll free) 

World Headquarters 
Intel Corporation 

Scalable Systems Division 
15201 N.W. Greenbrier Parkway 

Beaverton, Oregon 97006 
U.S.A. 

(503) 677-7600 (Monday through Friday, 8 AM to 5 PM Pacific Time) 
Fax: (503) 677-9147 

If you have comments about our manuals, please fill out and mail the enclosed Comment Card. You 
can also send your comments electronically to the following address: 

techpubs@ssd.intel.com 
(Internet) 
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SPV Overview 

The System Performance Visualization tool (SPV) allows you to monitor the performance of your 
Paragon ™ system. SPY allows you to do the following: 

Display the Paragon system front panel lights on your workstation 

• Display CPU, Mesh, and memory bus utilization values 

• Display the current, an average, or the maximum value of performance information 

Zoom from all of the CPUs to a few CPUs 

• Record and playback the performance displays 

The performance data used for the SPY display is CPU, Mesh, and memory bus utilization. The 
Reprogrammable Performance Monitoring (RPM) chip on each node board collects Mesh and 
memory bus information while the Mach Kernel collects CPU idle-time information. Each second 
the node collects performance data and sends the data to a process running on a service node. This 
process forwards the performance data to SPY running on the Paragon system. 

Graphical Displays 
Spy uses the OSF Motif toolkit for its graphical interface. The pull-down menus, commands, 
buttons and dialog boxes are described in Chapter 2. SPY provides four basic displays. These 
displays are 

• CPU display 

• Mesh Display 

Values Display 

• Node Display 

1-1 
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All four of the basic displays use color or gray scale along with stipples to denote utilization. You 
can configure the mapping between color, gray scale, or stipples to a particular utilization value or 
partition with X resources. Chapter 3 describes the X resources used to configure SPY. A custom 
dialog box is available to show the current mapping of utilization value to color, gray scale, and 
stipples. This dialog is described in Chapter 2 in the section titled Show Utilization Color Mappings. 

The default SPY display is sized to show all nodes of the system. If you want a larger display, you 
must use X geometry resources to provide a larger SPY window and default display. 

The following sections describe the four basic SPY displays. There are a number of display options 
for the basic SPY displays. These options are described in Chapter 2 in the section titled Change 
Data Display Options. You can move between the different displays by using the Zoom menu at the 
top of the SPY display window. 

CPU Display 

1-2 

The CPU display shows CPU utilization. The color (or grey scale) and stipple of each CPU shown 
in the display denotes the utilization for that CPU. The Mesh utilization is not displayed. Because of 
the number of nodes in a large Paragon system, the CPU utilization display may be the only display 
that shows all of the system. The display is also useful in a small window to monitor the performance 
of the Paragon system on an ongoing basis. There are two versions of the CPU utilization display: 
one where only the CPUs are shown and one where the Mesh is drawn. Figure 1-1 shows the 
CPU-only display, and Figure 1-2 shows the mesh display. 

Figure 1·1. CPU Utilization Display (CPU's only) 
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Figure 1-2. CPU Utilization Display (Mesh) 

The background color, gray scale and stipple patterns denote partitions. In Figure 1-1 and Figure 1-2, 
the light gray background denotes lID nodes while the darker cross-hatched background denotes the 
service partition. 

1-3 
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Mesh Display 

1-4 

The Mesh display is a visualization of the Paragon system front panel. As shown in Figure 1-3, both 
CPU and Mesh utilization are displayed. The color (or grey scale) and stipple of each mesh link 
shown in the display denotes the utilization for that link. 

Figure 1-3. Mesh Display 
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Values Display 

The values display shows the actual utilization values. As shown in Figure 1-4, both the CPU and 
Mesh utilization values appear. The node's compute CPU utilization is in the center in a larger font 
while the message passing CPU utilization is at the bottom in a smaller font. The mesh utilization 
values are shown on the mesh links. 

Figure 1-4. Values Display 

1-5 
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Node Displays 

1-6 

The node display presents CPU, Mesh, and memory bus utilization. The node display is a logical 
depiction of a node showing the CPUs, the message passing L TU, the memory bus, and main 
memory. Figure 1-5 shows a GP node and Figure 1-6 shows an MP node. Figure 1-7 shows an I/O 
node, where the I/O daughter card is depicted above the main memory module. Inside the I/O 
daughter card is the type of the I/O card, in this case, BOOT. The background color, gray scale and 
stipple in each module denotes the utilization value shown in the foreground. 

Node 7 CBS OOA02 

Figure 1·5. GP Node Display 

At the top of the node display are the root partition node number and the cabinet backplane slot 
. (CBS) number for the node. In Figure 1-7 these values are Node 3 and OOA03. 

At the left of the node display are the compute CPU(s), the message passing CPU (MsgP), and the 
LTU. The utilization value shown for the CPU is the percentage of time that the CPU has been busy. 

---". 
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Figure 1-6. MP Node Display 

To the right of each CPU (inside the memory bus) is the amount of time the CPU has been master 
of the memory bus. Since it is expensive in terms of time to become the master of the memory bus, 
the compute CPU(s) is/are always given the bus by default. The other bus utilization values denote 
when the message-passing CPU, LTV, or I/O daughter card become the bus master and indicates 
their actual memory bus usage. The LTV and I/O daughter utilization values represent their memory 
bus usage (the same value that is presented in the memory bus). 

The total memory bus usage is shown in the memory bus at the left of the memory module. The total 
is always roughly 98%, since CPU 1 always is a bus master even when it is not using the bus and 
approximately 2% of the bus cycles are used for memory refresh. The values inside the memory 
module are the percentage of memory allocated, the percentage of wired memory, and the number 
of faults per second. It is important to note that this is the total number of faults, not just page faults. 
Wired memory represents memory that can not be swapped. 

1-7 
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Node 3 CBS OOAOO 

0.0% I/O BOOT 

Figure 1-7. 110 Node Display 

Zooming Between Displays 

1-8 

The mouse buttons allow you to zoom back and forth between displays. The default settings for the 
buttons are as follows: 

Left button select 

Middle button return to previous display 

Right button display the Utilization Color Mappings dialog 
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When you click on a node in the display area with the select button, Spy zooms to the node display 
for that individual node. You can examine the node, and then use the return mouse button to zoom 
back to the previous display. This allows you to easily examine individual nodes from the CPU or 
mesh display. 

You can also use rubberbanding to zoom in on nodes in the display. To zoom in on selected nodes, 
hold down the select mouse button and drag the mouse to form a rectangle around the nodes you 
want to zoom in on. When you release the mouse button, Spy zooms in on the nodes in the rectangle. 

Starting SPV 
To run Spy on the Paragon system do the following: 

1. Enter the following command on your workstation: 

%xhost + paragon_system 

where paragon_system is the name of the Paragon system on which you are going to run SPY. 

2. Log onto the Paragon system. 

3. Set the DISPLAY environment variable to your workstation as in the following example: 

%setenv DISPLAY machine_name: 0 

where machine_name is the name of your workstation. 

4. Check to be sure you have /usr/binIXl 1 in your search path. 

5. Start SPY. 

To start SPY, use the SPy command as follows: 
SPy [{ -f I -file I -fileName} file_name] [{ -h I -host I -hostName} hoscname] [X Toolkit 
parameters] 

The SPy command parameters are as defined follows: 

{ -f I-file I -fileName} file_name 
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The file_name parameter is the name of a file that contains previously-saved SPY 
data. The -fileName flag is the same name as the X resource used to specify a file 
name. By specifying a file, you can playback previously saved SPY data. Along 
with the main SPY display window, SPY also displays the Playback dialog box 
(see the File Menu Open Playback command). 

{ -h I -host I -hostName} hosCname 

The hoscname parameter is the Internet machine or system name of the Paragon 
system. The -hostName flag is the same name as the X resource used to specify a 
host name. This parameter is used to specify the Paragon system displayed when 
you start SPY. If you run Spy on a Paragon system, the host name need not be 
specified. 

X Toolkit standard parameters 

These are the standard parameters supported by the X Toolkit. 

You can also use SPY from ParAide, the graphical front end to the Paragon system application 
toolset. For a description of ParA ide, refer to the Paragon™ System Application Tools User's Guide. 

When you run Spy on the Paragon system, Spy runs on a service node with the output displayed 
on your workstation. 

When you start SPY, it does one of the folJowing: 

• If you use {-f I-file I-fileName} to define a file containing previously recorded SPY data, SPY 
plays back the data. 

• If you use {·h I -host I -hostName} to define a Paragon system host name, you connect to the 
Paragon system and SPY begins displaying performance data. 

• If the X resource hostName is defined, you connect to the Paragon system defined by the X 
resource and SPY begins displaying performance data. 

• If you are executing Spy on a Paragon system, you connect to the SPY colJection process 
running on the Paragon system and SPY displays performance data for that system. 

As Spy attempts to connect to the SPY data collection process, a working dialog displays with the 
following message: 

Attempting to connect to host name 

host name is the name of the Paragon system. If Spy fails to connect to the Paragon system, an error 
dialog displays and the Host Name dialog appears so you can change the host name. 
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SPV Error Conditions 
There are several errors that can occur when you use SPY. If the Paragon system is unable to connect 
to your system, you get the following message: 

Client refusing connection 

If you get this message, run xhost as described in the section Starting SPY. 

If Spy is unable to open a display on your workstation, you get the following message: 

Unable to open display 

If you get this message, set your DISPLA Y environment variable as described in the section 
Starting SPY. 

If your resources are not set correctly, SPY displays an error message. If you get a resource error 
message, check your resource file to be sure your resources are set correctly. For information on 
resources, refer to Chapter 3, Configuring SPY. 

If an error occurs while SPY is running, an error dialog appears and the error message displayed in 
the dialog is also displayed on the SPY status line (refer to Figure 2-1). If you dismiss the error 
dialog, the status line contains the error message until the state of SPY changes. 

Socket Errors 

If the Paragon system responds with bad data over the socket connection, or if the socket connection 
is terminated for any reason, an error message dialog is displayed with the following message: 

Socket error, connection lost at (date at which connection lost) 

This error condition can be caused by the system administrator terminating the SPY data collection 
daemon, the network failing, or the system failing. If SPY is executing on a workstation, anyone of 
the failure conditions could be the cause. However, if SPY is executing on the displayed system, then 
for network Of system failures SPY itself is likely to fail. If SPY is still working, the system 
administrator has probably terminated the SPY data collection daemon. You can determine if this is 
the case by entering a ps -e command and looking for lusrllibltoolenvlbinlspvdaemon. 

To dismiss the error dialog, select the OK button. SPY stops displaying the performance data but 
leaves the last display to show the state of the system when the socket connection was lost. You can 
use the Host Name command to reconnect to the system, or the Exit command to exit SPY. 

Response Errors 

If the Paragon system fails to respond with performance data within 10 seconds, an error dialog 
appears with the following message: 

1-11 



SPV Overview Paragon™ System Performance Visualization Tool User's Guide 

possible system failure, no response from system for 10 seconds 
at (time system stopped responding) 

Because a "Socket error, connection lost" error was not reported, the network still functions and the 
SPY data collection daemon continues to run. However, the SPY data collection daemon does not 
respond to requests for performance data by SPY. The most common cause of the error condition is 
that the SPY data collection daemon has been paged out and excessive paging by the system is 
preventing the daemon from running. If this is the case, at some point the SPY data collection 
daemon will respond, and SPY will continue to display system performance data. In very rare cases, 
the error condition can be caused by the partial failure of the SPVdata collection daemon or the 
partial failure of the system. In this case, the SPY data colle~tion daemon should be terminated and 
restarted. 

To dismiss the error dialog, select the OK button. The SPY utilization display does not change and 
shows the state of the system at the time the system stopped responding. If the system starts 
responding, the status line shows what is being displayed and the error dialog remains until you 
dismiss the dialog. 

Blocking Errors 

1-12 

If the SPY data collection process is blocked due to excessive paging or because a node stopped 
responding, the same data is reported by the collection process. If the same data is reported for more 
than 10 seconds, an error dialog appears with the following message 

possible node failure, same data reported for 10 seconds at (time 
system started reporting the same data). 

The data is collected via a spanning tree and the failure of one node to respond causes the spanning 
tree to fail. Thus, the same data is reported by the SPY data collection daemon. The error condition 
can be caused by excessive paging on the node or by the failure of the node. If the error is due to 
excessive paging, at some point the data will be collected and SPY will continue to display the 
system performance data. The error dialog can be dismissed. However if the error condition 
continues, it is likely that one of the nodes in the system has failed. 

To dismiss the error dialog, select the OK button. The SPY utilization display does not change and 
continues to show the state of the system at the time the system started reporting the same data. If 
normal data collection resumes and new data is reported, the status line shows what is being 
displayed and the error dialog remains until you dismiss the dialog. 
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Displaying Failing Nodes 

SPY identifies and displays nodes that are configured in a partition but not in the system and bad 
nodes. Figure 1-8 shows the two types of failing nodes. At the right, near the top of the SPY display, 
is a node (circle) with an horizontal line through the circle indicating an empty slot that is configured 
in the partition. This follows the showpart command convention of showing a minus sign when an 
empty slot is configured in a partition. Spy does not show the mesh arrows, which further indicates 
that the node is not in the mesh. 

At the right near the bottom is a node with a large X superimposed over the node. This denotes a bad 
node and follows the showpart command convention of displaying an x for a bad node. Bad nodes 
are nodes that do not boot properly when the system is initialized. The list of bad nodes is found in 
the file letdnxl.badnodes. 

If you click on the bad node with the select button, Spy zooms to the node display for the node. This 
allows you to identify and examine bad nodes. 

Figure 1·8. Failing Node Display 

Figure 1-9 and Figure 1-10 show failing nodes for the close-up node display. Figure 1-9 shows an 
empty slot configured into the partition and Figure 1-10 shows a bad node. 
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Figure 1-9. Close-up Failing Node Display (Empty Slot) 
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Figure 1-10. Close-up Failing Node Display (Bad Node) 
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Windows, Menus, and Commands 

This chapter describes the windows, menus, and commands offered by SPY. The main window is 
the SPY display window. The following section describes the SPY display window. 

SPV Display Window 
The main SPY display window shows the Paragon TM system front panel. Figure 2-1 shows the 
various components of the SPY display window. 
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Pull-down menus Window border ------... 

Scroll Bars 

Figure 2-1. SPY Display Window 

Pull-Down Menus 

Title bar 

2-2 

The pull-down menu bar is at the top of the window. The File pull-down menu is at the far left of 
the menu bar, followed by the Options pull-down menu and the Zoom menu. The Help pull-down 
menu is at the far right of the menu bar. 

The title bar contains the name of the tool (SPV) and the name of the Paragon system SPY is 
displaying or the name of the file being replayed. 
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Window border 

The window border defines the SPY window area. The window border is provided by the window 
manager. 

Status Line 

The status line contains the current Spy status. During normal operation the status line describes 
what is being displayed. At the left of the status line is the header, Display:. To the right of the header 
is either current, average, or maximum, depending upon whether the current, average or maximum 
value of the data is being displayed (see Display Options). To the right of the current, average or 
maximum is a description of what is being displayed. The description is one of the following: 

For the CPU display: 

CPU utilization 
Memory utilization 
Wired memory utilization 
Page faults/sec 

For the Mesh display: 

CPU & Mesh utilization 
Memory & Mesh utilization 
Wired memory & Mesh utilization 
Page faults/sec & Mesh utilization 

For the Values display: 

CPU & Mesh values 
Memory & Mesh values 
Wired memory & Mesh values 
Page faults/sec & Mesh values 

For the Node display: 

CPU, Mesh, Bus & Memory values 

When an error occurs (see Spy Error Conditions in Chapter 1) an error message appears in an error 
dialog and in the status line. If you dismiss the error dialog, the error remains present in the status 
line until the state of SPY changes. 

2-3 



Windows, Menus, and Commands Paragon™ System Performance Visualization Tool User's Guide 

Display Area 

The Display Area is where the front panel displays appear (see Graphical Displays in Chapter 1). 

Scroll Bars 

The scroll bars are at the right and bottom of the window. The scroll bars allow you to scroll the SPY 
display up, down, left, or right. The scroll bars are needed if the display area is smaller than what is 
required for a full-system display. 

When you resize the window using window manager functions, more or less of the display image 
appears in the display area. Spy also provides zoom-in and zoom-out to enlarge or shrink the image 
(see Zoom menu). By varying the window size, the image zoom, and the scroll bars you can specify 
what part of the front panel to display and the exact size of the displayed image. 

File Menu 

2-4 

The File menu is at the far left of the menu bar and, for a non-root user, contains the following 
commands: 

• Open Playback 

• Record Data 

• Save Options 

• Host Name 

• Exit 

Figure 2-2 shows the File menu. 
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Figure 2-2. File Menu 

For a root-privileged user running on the Paragon system, the Data Collection command appears 
just before the Exit command. The File menu with the Data Collection command is shown in Figure 
2-3. 

Figure 2-3. File Menu with Data Collection Command 
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Open Playback 

2-6 

The Open Playback command allows you to replay previously-saved SPY data. You first choose a 
file, then SPY displays a Playback dialog box to allow you to control the playback. When the 
Playback dialog is visible, the File Menu Open Playback menu is desensitized. At the end of the 
Playback, you dismiss the Playback Dialog, and SPY stops the playback and closes the playback file. 

Open Playback File Selection Dialog 

The Open Playback command allows you to specify a file containing the SPY data. Figure 2-4 
shows the dialog used by the Open Playback command. 

Figure 2-4. Open Playback File Selection Dialog 
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To select a file for playback, select a file name and then select the OK button. 

If you specify a file (directory or special file) other than an ordinary file, Spy displays an error dialog 
containing the following message: 

Not a file: file name. 

If you specify a file that does not exist, SPY displays an error dialog containing the following 
message: 

File not found: file name. 

If you specify the same file name that is currently being used to record data (see Record Data), SPY 
displays an error dialog containing the following message: 

The file that you want to open is the same as the recording file: 
file name. 

If the file does not contain recognizable SPY data, SPY displays an error dialog containing the 
following message: 

Not an SPV data file: file name. 

To dismiss any of these error dialogs, select the OK error dialog button. 

The file selection dialog's features are as follows: 

Filter 

This text field contains the filter for displaying files. SPY displays all file names, but you have the 
option of filtering out files by using file name wild cards. 

Directories 

All directories in the current directory that pass through the filter are listed. Selecting a directory 
makes it the current directory. 

Files 

All files in the current directory that pass through the filter are listed. It is possible for the list to be 
empty if no files match the filter or if the current directory is empty. If a file is selected, it becomes 
the selection for the file dialog. 
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Selection 

This text field contains the name of the currently-selected playback file. 

OK 

When you select the OK button, SPY checks the file in the selection text field. If the file is valid, the 
file selection dialog is dismissed and the Playback dialog appears. If the file is not valid, error and 
question dialogs appear. 

Filter 

When selected, the entry in the Filter field is used to obtain a new file list and a new directory list. 

Cancel 

When selected, the file selection dialog is dismissed. 

Help 

The help button displays help information on the Playback topic. 

Open Playback Dialog 

Once you choose the playback file, the name of the file appears in the SPY title bar and the playback 
dialog appears to allow you to control the replay of the performance data. Figure 2-5 shows the 
playback dialog. 
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The Playback dialog contains playback information, a scale that shows the playback location, a 
toggle button that signifies to start the playback, the Done button and the Help button. The initial 
playback state is to start the playback, (the toggle button in). In order to stop the playback you must 
select the toggle button. The Playback dialog contains the following features: 

File 

The name of the file containing the performance data being read. 

Time 

The time at which the SPY data was recorded. This field changes as SPY displays each new image. 

Image 

The current SPY display or image. The images or displays are numbered sequentially from the 
beginning of the recording. This field changes as SPY displays each new image. 
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Playback Location 

A scale is provided that indicates where in the file the replay is occurring. The scale also allows you 
to move around in the file. The values above the scale denote an image number. If the number of 
images to playback is less than or equal to 12, then all 12 image numbers will be displayed above 
the scale. However, if the number of images is greater than 12, only the image numbers 
corresponding to 0%, 25%, 50%, 75% & 100% ofthe file are displayed. If you change the playback 
location by manipulating the scale, the playback stops and must be activated by selecting the toggle 
button. 

Select to Start/Stop Playback 

This toggle button activates the playback mode. 

Done 

The Done button exits the playback mode. SPY closes the playback file and dismisses the Playback 
dialog. 

Help 

The help button displays help information on the SPY Playback dialog features. 

Record Data 

2-10 

The Record Data command allows you to save SPY data. You first choose a file, then SPY displays 
a record dialog box to allow you to control the recording of the performance data. When the record 
dialog is visible, the File Menu Record Data command is desensitized. At the end of the recording, 
you dismiss the record dialog, and Spy stops recording data and closes the record file. 

Record Data File Selection Dialog 

The Record Data command allows you to specify file names that are used to record data. Figure 2-6 
shows the dialog used by the Record Data command. 
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Figure 2-6. Record File Selection Dialog 

To select a file for recording, select a file name and then select the OK button. 

If you specify a file (directory or special file) other than an ordinary file, SPY displays an error dialog 
that contains the following message: 

Not a file: file name. 

Select the OK error dialog button to dismiss the error dialog. 

If you specify a file that already exists, and the file is write protected, SPY displays an error dialog 
that contains the following message: 

This file name is currently write protected: file name. 
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You must select OK to confirm the dialog, and then change the file permissions, delete the file, or 
use another file name. 

If you specify a file that already exists, and the file is not write protected, Spy displays a question 
dialog that contains the following message: 

File already exists, delete? 

If you select the question dialog Yes button, the question dialog and file selection dialog are 
dismissed, and the existing file is deleted and used as the recording file. If you select the No button, 
the question dialog is dismissed and the file selection dialog remains. 

If you specify the same file name that is currently being used to Playback performance data (see 
Open Playback), SPY displays an error dialog containing the following message: 

The file that you want to create is the same as the playback file: 
file name. 

Select the OK error dialog button to dismiss the error dialog. 

The file selection dialog's features are as follows: 

Filter 

This text field contains the filter for displaying files. All file names are displayed, but you have the 
option of filtering out files by using file name wild cards. 

Directories 

All directories in the current directory that pass through the filter are listed. Selecting a directory 
makes it the current directory. 

Files 

All files in the current directory that pass through the filter are listed. It is possible for the list to be 
empty if no files match the filter or if the current directory is empty. If a file is selected, it becomes 
the selection for the file dialog. 

Selection 

This text field contains the name of the currently-selected record file. 
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OK 

When you select the OK button, SPY checks the file in the selection text field. If the file is valid, the 
file selection dialog is dismissed and the Record dialog appears. If the file is not valid, error and 
question dialogs appear. 

Filter 

When selected, the entry in the Filter field is used to obtain a new file list and directory list. 

Cancel 

When selected, Spy dismisses the file selection dialog . 

Help 

The help button displays help information on the Record Data topic. 

Record Data Dialog 

Once you have chosen a file name, the file selection dialog is dismissed, and the Record dialog 
appears to allow you to control the recording of the performance data. Figure 2-7 shows the Record 
dialog. 
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Figure 2-7. Record Dialog 

The Record dialog contains record information, a toggle button that signifies to start the record 
mode, a Done button, and a Help button. The initial record state is to not record (the toggle' button 
out). In order to start the recording, you must select the toggle button. The record dialog box contains 
the following features: 

File 

The name of the file where the performance data is to be recorded. 

Bytes 

The total number of bytes in the file, including any header information. This field changes as SPY 
records each new image. 

Image 

The current SPY display or image. The images or displays are numbered sequentially from the 
beginning of the recording. This field changes as SPY records each new image. 
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Select to Start/Stop Recording 

This toggle button activates the record mode. 

Done 

The Done button exits the record mode. SPY closes the record file and dismisses the Record dialog. 

Help 

The help button displays help information on the SPY Record features. 

Host Name 

The Host Name command allows you to specify the name of the Paragon system to be displayed. 
Figure 2-8 shows the Host Name dialog. 

Figure 2-8. Host Name Dialog 

The Host Name dialog's features are as follows: 

Enter Host Name 

The text field below this label is where you type the Paragon system host name or IP address. 
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OK 

When you select the OK button, SPY checks the host name in the text field. If SPY is able to connect 
to the Paragon system, the Paragon system name appears in the SPY title bar, and SPY starts 
displaying system performance data. If SPY is unable to connect to the Paragon system, the status 
line and an error dialog are displayed containing the following message: 

Can not connect to host name. 

Select the error dialog OK button to dismiss the error dialog. 

Cancel 

When selected, SPY dismisses the Host Name dialog. 

Help 

The help button displays help information on the Host Name topic. 

Save Options 

2·16 

The Save Options command saves the options, colors, and patterns that you can dynamically 
configure with the Options menu dialogs. The options, colors, and patterns are written out as Spy 
X resources to the file Spv in your home directory. The next time you run SPY, the standard X 
resource search path reads the file Spv in your home directory and uses these resources to override 
any application default X resources. 

When you save the options, colors, and patterns with the Save Options command, SPY displays an 
information dialog with the following message: 

The changes have been made to your Spv resource file. The changes 
will take effect next time you execute spv. 

Select the information dialog OK button to dismiss the information dialog. 

If access permissions are not set correctly on your resource file, SPY displays an error dialog with 
the following message: 

Can't open filename: permission denied. 

pathname is the name (with full path) of your resource file. Select the error dialog OK button to 
dismiss the error dialog. 
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Data Collection 

Exit 

The Data Collection menu is a pull right menu with the following two submenu commands: Pause 
and Continue. These commands allow a root-privileged user to temporarily stop (pause) Spy data 
collection, and once the data collection is stopped, to continue data collection once again. 

The Pause command stops data collection, but Spy data collection processes are still allocated on 
every node. For the Pause command, a question dialog appears with the following message: 

Are you sure you want to stop the SPV data collection? 

Selecting the question dialog Yes button stops SPY data collection. Selecting either dialog button 
dismisses the dialog. 

When data collection is stopped, at the next time interval update of the SPY display an error dialog 
appears with the following message: 

SPV data collection stopped by root user at time stopped. 

Selecting the OK button dismisses the error dialog, but the status line still contains the error message. 
The SPY utilization display does not change and shows the state of the system at the time the data 
collection was stopped. 

When the root user selects the Continue command to start Spy data collection, at the next timer 
interval update of the Spy display, an information dialog appears with the following message: 

Data collection resumed. 

Selecting the OK button dismisses the information dialog. The Spy status line is replaced with the 
normal operating message that describes what is being displayed. 

SPY ignores selecting the Continue command when the data collection is already started. 

The Exit command allows you to exit SPY. SPY displays a question dialog with the following 
message: 

Are you sure that you want to exit SPV? 

If you select the Yes button, Spy exits. If you select the No button, SPY continues to display 
performance data. Selecting either the Yes or No button dismisses the question dialog. 
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Options Menu 
The Options menu is to the right of the File menu and contains the following commands: 

2-18 

• Change Data Display Options 

Show Utilization Color Mappings 

• Show Partition Color Mappings 

• Change Color Options 

Figure 2-9 shows the options menu. 

Figure 2·9. Options Menu 
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Change Data Display Options 

The Change Data Display Options command allows you to modify various SPY display options. 
Figure 2-10 shows the Display Options dialog you can use to modify the Spy display options. 

Figure 2·10. Display Options Dialog 
2-19 
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2-20 

The Display Options dialog allows you to change the following: 

• what utilization values are displayed 

• how the CPU values are computed 

• whether the message passing process is included in the CPU calculations 

• the update time 

• the zoom scale factor 

• the maximum page fault rate 

The Display Options dialog features are as follows: 

For CPU, Mesh & Values Zoom show 

This region contains the following buttons: 

• CPU Utilization 

• Memory usage 

• Wired memory usage 

• Page faults per second 

The currently-selected button determines which information is displayed in the CPU, Mesh, and 
Value displays. The SPV status line also reflects what is being displayed. 

Show utilization as 

This region contains three radio buttons that allow you to choose what utilization values are 
displayed. The buttons are: 

Current value displays the current utilization value 

Average value displays a running average of the utilization values 

Maximum value displays the maximum utilization value obtained to this point 

The average and maximum values can be reset to zero at any time with the Reset Average & 
Maximum toggle button. 

------------------~~.-.. ---------.-.---
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Compute CPU values as 

If the Message Passing processor is included in the CPU calculations, this region is used to specify 
how CPU utilization is computed for the CPU display, the Mesh Display, and the background CPU 
color for the values display. The region contains three radio buttons. By selecting the buttons you 
can specify that SPY show the average of the CPUs, the maximum of the CPUs or the minimum of 
the CPUs. 

Include Message Passing CPU in calculations 

This toggle button is used to specify whether the message passing CPU is included in the CPU 
calculations. If the toggle button is out, the message passing CPU is not included. If the toggle button 
is in, the message passing CPU is included in the CPU calculations. 

Reset Average & Maximum 

This toggle button allows you to reset the computed average and maximum values. SPY can display 
either the current utilization values, a running average, or the maximum value. This toggle button 
resets the average and maximum values to zero. From the point at which the values are reset, Spy 
computes new values. After you select the OK or Apply button, the toggle button resets to the off, 
or out position. 

Update Time (sees) 

You can modify this text field to specify the SPY update time interval. This is the time interval at 
which the Spy display is updated. The time is specified in seconds and can range from 0 to the 
largest positive integer. A value of zero indicates to update as fast as possible. If you enter an illegal 
value, Spy displays an error dialog with the following message: 

Illegal negative update time. 

Zoom in/out scale 

You can modify this text field to specify the scale factor that is multiplied by the current display to 
zoom either in or out. The scale factor is specified as a floating point number (an x or X is permitted 
as a suffix and is ignored). If you enter an illegal value, SPY displays an error dialog with the 
following message: 

Illegal Zoom in/out scale. Valid values: 1.0 <= scale <= 100.0". 

Max Page Faults/sec 

Because page fault information is given in terms of page faults per second, a maximum page fault 
value is needed to convert to a 0% to 100% range. You can specify that maximum in this field. The 
value must be greater than zero . 
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Show Utilization Color Mappings 

2-22 

The Show Utilization Color Mappings command displays a custom dialog that contains the 
mapping of utilization values to color, gray scale, and stipples. The dialog contains a table with the 
range of utilization values on the left and the corresponding color, gray scale, and stipple on the right. 
When a utilization value falls within a range, Spy uses the corresponding color, gray scale, and 
stipple to represent that utilization value in utilization displays. 

The smallest range change is 0.1 %. A value of less than 0.1 % indicates any value greater than zero 
but less than 0.1 %. For the default color mappings display the header "Any%" appears in the second 
to last color-value pair and the last color-value pair is 0% - 0%. You can change the utilization color 
mappings with the Change Color Options dialog or the SPY utilizationColors X resources. 

Figure 2-11 shows the Utilization Color Mappings dialog. The dialog contains OK and Help buttons. 
When you select the OK button, SPY dismisses the dialog. When you select the Help button, SPY 
displays a help dialog on the Utilization Color Mappings topic. 

Figure 2·11. Utilization Color Mappings Dialog 
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Show Partition Color Mappings 

The Show Partition Color Mappings command displays a custom dialog box that contains the 
mapping of partitions to color, gray-scale, and stipples. The dialog contains a table with the full 
partition name on the left and the corresponding color, gray scale, and stipple on the right. When a 
node falls within the partition, SPY displays the corresponding color as the node's background color. 
You can change the partition color mappings with the SPY Change Color Options dialog or the 
partitionColors X resource. 

Figure 2-12 shows the Partition Color Mappings dialog. The dialog contains OK and Help buttons. 
When you select the OK button, SPY dismisses the dialog. When you select the Help button, SPY 
displays a help dialog on the Partition Color Mappings topic. 

Figure 2·12. Partition Color Mappings 

The order in which the partitions are listed in the dialog is also the same order in which the partitions 
are applied to the nodes, except the service partition is always applied last. Because the Paragon 
system supports sub-partitions and partitions that overlap, the color shown for the background of the 
node corresponds to the last partition in the list or the leaf components of the partition tree. The one 
exception is the service partition which is always the last partition applied to the nodes. 
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Change Color Options 

2-24 

The Change Color Options command allows you to change the color and stipple of the text 
foreground and background in the display area, as well as the utilization and partition colors. When 
you select the Change Color Options command, SPY displays the Choose Patterns and Colors 
dialog, shown in Figure 2-13. At the top of the dialog is a pop-up menu used to select which color 
is to be changed. The pop-up menu is divided into three sections: the top section for selecting the 
display area text foreground and background colors, a middle section for selecting the utilization 
colors & stipples and the bottom section for selecting the partition colors & stipples. 

As you choose a color and stipple pattern, the area under the pop-up menu at the top of the dialog 
changes and the corresponding SPY display item also changes to show the color and pattern. 

You can also use the dialog to find a particular partition. If you use the pop-up menu to select a 
partition name, SPY immediately applies the partition's color and stipple to the nodes. By changing 
the partition color and stipple, you can immediately see which nodes are in the partition. 
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Figure 2-13. Choose Patterns and Colors Dialog 
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2-26 

The features of the Choose Patterns and Colors dialog are as follows: 

Set Color and Pattern for 

This pop-up menu allows you to specify which display feature you want to set colors and patterns 
for. The current color to be changed is shown within the large area immediately below the pop-up 
menu. 

Named Color 

This area contains a listing of the colors you may choose. 

Color value 

This area contains three scale widgets and two arrow buttons that allow you to adjust the 
red/greenlblue components and the brightness of the currently selected color. By moving the scales, 
you can change the red/greenlblue components of the selected color. The Brightness up arrow makes 
the selected color brighter while the down arrow makes the selected color darker. 

Palette 

This area contains a palette of related colors and three radio buttons. The radio buttons control the 
colors depicted in the palette. The radio buttons are: 

Range displays a range of colors in the palette 

Wide displays a wide range of colors similar to the selected color 

Narrow displays a narrow range of dark to light of the selected color 

Match 

If you set a color with the Color value scales or by the Palette, you can use the Match button to find 
the closest corresponding color name. The color list under the header Named color highlights the 
name of the color. 

Pattern Names 

This area contains the names of the stipples SPY supports. If you select one of the names, the stipple 
pattern is applied to the selected color. 

• • • 
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Available Patterns 

Choosing one of the patterns shown in this area applies the pattern to the selected color. 

OK 

Saves the changes made to the dialog. 

Apply 

Saves the changes made to the dialog. 

Cancel 

Discards the changes made and dismisses the dialog. 

Zoom Menu 
The Zoom menu provides commands to enlarge or shrink a display (zoom in or out) and to zoom 
directly to different graphical displays. The SPY displays are scalable to any size. You can configure 
the zoom scale with the Display Options dialog from the Options menu. 

Figure 2-14 shows the Zoom menu. 
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Zoom out 

Zoom in 

Best Fit 

2-28 

Figure 2-14. Zoom Meuu 

The Zoom out command allows you to zoom out. The display area becomes smaller by the zoom 
in/out scale factor (see Display Options). The same image appears, but smaller. 

The Zoom in command allows you to zoom closer.The display area becomes larger by the zoom 
in/out scale factor (see Display Options). The same image appears, but larger. 

The Best Fit command allows SPY to compute the largest picture that can be displayed in the 
display area. You can use this command to quickly find the largest zoom that shows the entire 
system. This is the default zoom that SPY uses when it is started in order to fit the entire system 
display inside the geometry of the SPY window. 
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Previous Zoom 

The Previous Zoom command allows you to switch back to a previous zoom display. SPV 
maintains a stack of the last four zooms. 

Zoom to CPUS 

The Zoom to CPUs command allows you to change the display to the CPU display. 

Zoom to Mesh 

The Zoom to Mesh command allows you to change the display to the Mesh display. 

Zoom to Values 

The Zoom to Values command allows you to change the display to the Values display. 

Zoom to Nodes 

The Zoom to Nodes command allows you to change the display to the Nodes display. 

Help Menu 
The Help menu provides commands to display help information. Figure 2-15 shows the Help menu. 
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Figure 2-15. Help Menu 

On Context 

Index 

2-30 

The On Context command provides context-sensitive help about the situation that exists when help 
is requested. When you select this command, the pointer shape changes to a question mark. Selecting 
any part of the SPY window displays a help dialog specific to the part of SPY selected. 

The Index command displays a scrolled list that contains an index of the SPY help topics. You can 
select a topic, and a help dialog appears for that topic. When you select the Done button, SPY 
dismisses the index dialog. Figure 2-16 shows a help index dialog. 
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On Help 

Figure 2-16. Help Index Dialog 

The Help command provides information about SPY's help facilities. A help dialog appears that 
describes how to use the help facilities. 

On Version 

The On Version command displays a dialog showing the name, version, and date of SPV. Selecting 
the OK button dismisses the version dialog. 
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On Overview 

The On Overview command displays a help dialog that provides an overview of SPY. 

On Main Panel 

The On Main Panel command displays a help dialog that provides help on SPY's main panel. 

On Menu Commands 

The On Menu Commands command displays a help dialog that provides help on SPY's menu 
commands. 

On Display 

The On Display command displays a help dialog that provides help on SPY's graphical displays. 

On Xresources 

The On Xresources command displays a help dialog that provides help on SPY's X resource 
specifications. 

On Invocation 

The On Invocation command displays a help dialog that provides help on SPY's command line 
syntax. 

Help Dialog 

2-32 

A help dialog appears whenever you choose a specific help topic. As shown in Figure 2-17, the 
dialog contains text giving help on the requested topic, a subtopics menu, and a Done button. 
Selecting the Done button dismisses the help dialog. 
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Figure 2-17. Help Dialog 

In the help text, keywords or phrases that are underlined denote subtopics for which further help 
information exists. If you select an underlined item by clicking on it, a new help dialog appears 
giving help on the selected keyword or phrase. The same keywords and phrases are also presented 
in the subtopics menu at the upper right of the dialog. Figure 2-18 shows the help dialog subtopics 
menu. 
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Figure 2·18. Help Dialog Subtopics Menu 
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Configuring SPY 

You can configure SPY by using X resources. Refer to the X documentation for definitions of the X 
resources. The Spy resources fall into the following configuration categories: 

File name X resources 

• Display option X resources 

• Utilization colors X resources 

• Partition colors X resources 

• Font X resources 

• Mouse button 2 and mouse button 3 X resources 

• Keyboard accelerator X resources 

File Name X Resources 
The X resources that configure SPY file or path names are as follows: 

Spv*fileName: 

The file name resource specifies the file opened by Spy to playback previously saved system data. 
Refer to the descriptions of the File Menu Open Playback and the File Menu Record Data 
commands. 

3-1 
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Spv*hostName: 

The host name resource specifies the Paragon TM system to which SPY connects and for which SPY 
displays system performance information. Refer to the description of the File Menu Host Name 
command. 

Display Option X Resources 
The X resources used to configure the SPY Options Menu Display Options are shown in Table 3-1. 

Table 3·1. Display Option X Resources 

X Resource Value 

Spv*showUtilizationOf: {cpu I memory I wired I faults} 

Spv*maxPageFaults: positive number greater than 0 

Spv*showUtilizationAs: { current I average I maximum} 

Spv*includeMsgPinCPUs: {True I False} 

Spv*computeCPUutilizationAs: {average I minimum I maximum} 

Spv*updateTime: positive integer value 

Spv*zoomScale: 1.0 <= float value <= 100.0 

Refer to the description of the Options Menu Display Options command for a detailed description 
of what is changed by these X resources. 

Utilization Colors X Resources 
The X resources to change the utilization color mappings are shown in Table 3-2. 

Table 3·2. Utilization Colors X Resources 

X Resource Value 

Spv*utilizationColors: float color _name float color_name ... 

Spv*utilizationStipples: float stipple_name ... 

3-2 
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Both of these resources are a set of values, where the first value is a floating-point value specifying 
a utilization value from 0.0 to 100.0 percent. The second value is either an RGB color value, an RGB 
color name as defined in lusrlliblXlllrgb. txt or an Spy stipple name. RGB names must be one name, 
rather than two names separated by a blank. An example utilization Colors resource is as follows: 

Spv*utilizationColors: 90.0 red \ 
80.0 yellow \ 
60.0 blue \ 
20.0 green \ 
0.0 white 

This example utilizationColors resource specification defines colors for 5 ranges: 

100.0% - 90.0 red 

89.9% - 80% yellow 

79.9% - 60.0% blue 

59.9% - 20.0% green 

19.9% - 0.0%. white 

If, for example, the utilization value falls within the 79.9% - 60.0% range, the color blue is displayed. 
If the values are given out of order in the specification, such as "20.0 green" being specified before 
"60.0 blue", the same ranges are displayed, since SPY reorders the values in ascending order. Any 
value less than 0.1 indicates a range of any value greater than zero. In the Utilization Color Mappings 
dialog and the Color Preferences dialog any value less than 0.1 % is indicated by "Any%". The 
maximum number of ranges and colors that can be defined is 20. 

For the Spv*utilizationStipple resource a stipple pattern is specified instead of a color. The stipple 
names are as follows: 

solid lineHatch largeLineHatch 
dotsVeryDark lineDiagHatch largeLineDiagHatch 
dotsDark lineDiagRight JargeLineDiagRight 
dotsNorm lineDiagLeft JargeLineDiagLeft 
dotsLight lineVert largeLine V ert 
dots Very Light lineHoriz largeLineHoriz 
stipple boxes cross_weave 
dimplel dimple3 none 
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Partition Colors X Resources 
The X resources to change the partition color mappings are shown in Table 3-3. 

Table 3-3. Partition Colors X Resources 

X Resource Value 

Spv*partitionColors: partition_name color_name ... 

Spv*partitionStipples: partition_name stipple_name ... 

Both of the resources are a set of values, where the first value is the full name of the partition and 
the second value is either an RGB color value, an RGB color name as defined in lusrl/iblXlllrgb. txt 
or an Spy stipple name (listed previously in Utilization Colors Xresources). RGB names must be 
one name, rather than two names separated by a blank. A maximum of 16 partitions can be defined. 

Font X Resources 

3-4 

The X resources to configure fonts are shown in Figure 3-4. 

Table 3-4. Font X Resources 

X Resource Value 

Spv*fontl: foncname 

Spv*font2: foncname 

Spv*font3: foncname 

Spv*font4: foncname 

Spv*font5: foncname 

Spv*font6: foncname 

These resources control the fonts used to display SPY text in the display window. The fonts 
represent a range of point sizes from small (font!) to large (font6). These correspond to the range of 
zooms from far-away zooms (zoom out) to close-in zooms (zoom in). The fonts do not have to be 
from the same font family or have particular point sizes. 

----~---~---
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The default values for these fonts differ, depending on whether you are running SPY on an XIIR5 
server or not. Refer to Appendix A for a list of the default fonts. 

Button 2 and Button 3 X Resources 
The middle mouse button (button 2) and the right mouse button (button 3) can be reconfigured using 
the SPY button2 and button3 X resources. In Table 3-5, the left column defines the menu, the middle 
column defines the command, and the right column defines the X resource string used to specify 
what the button does. 

Table 3-5. Button 2 and Button 3 X Resources 

Menu Command X Resource 

File Open Playback ... open 

File Record Data ... record 

File Save Options save 

File Host Name ... host 

Options Change Data Display Options ... options 

Options Show Utilization Color Mappings ... utilization 

Options Show Partition Color Mappings ... partitions 

Options Change Color Options ... colors 

Zoom Zoom Out out 

Zoom Zoom In in 

Zoom Best Fit best 

Zoom Previous Zoom previous 

Zoom Zoom toCPUs cpus 

Zoom Zoom to Mesh mesh 

Zoom Zoom to Values values 

Zoom Zoom to Nodes nodes 

The buttons are only active when the corresponding menu command is active (sensitized). If the 
command is desensitized then the button is also desensitized. 

You can not configure the left mouse button. By Motif convention, the left mouse button is used to 
select items. When you select a node in the Display Area, SPY zooms to the nodes display and 
centers the selected node inside the Display Area. 
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Keyboard Accelerator X Resources 

3-6 

SPV supports the standard Motif keyboard accelerator X resource conventions. The accelerators are 
specified first by the menu (file, options, zoom or help) name, followed by the menu item 
(command) name, followed by "accelerator" to define the accelerator key and "acceleratorText" to 
define the text placed in the pull-down menu. In Table 3-6, the left column defines the menu, the 
middle column defines the command, and the right column defines the X resource prefix used to 
specify the keyboard accelerator. 

Table 3-6. Keyboard Accelerator X Resources 

Menu Command X Resource 

File Open Playback ... file.open 

File Record Data ... file.record 

File Save Options file. save 

File Host Name ... file.host 

File Exit file.exit 

Options Change Data Display Options ... options.display 

Options Show Utilization Color Mappings ... options.utilization 

Options Show Partition Color Mappings ... options. partitions 

Options Change Color Options ... options.colors 

Zoom Zoom Out zoom.out 

Zoom Zoom In zoom.in 

Zoom Best Fit zoom. best 

Zoom Previous Zoom zoom.previous 

Zoom Zoom toCPUs zoom.cpus 

Zoom Zoom to Mesh zoom.mesh 

Zoom Zoom to Values zoom. values 

Zoom Zoom to Nodes zoom.nodes 
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Default SPV Configuration 

The Spy default configuration is defined in the application defaults file: 
lusrIUb/xJJlapp-deJaultsISpv. The application defaults file documents the default SPY resources, 
including the following: 

Cieneral resources 

• Keyboard accelerators 

• File name resources 

• Display option resources 

Button resources 

• Font resources 

• Color terminal resources 

• Ciray scale resources 

• Monochrome resources 

The following tables list the SPY defaults for these resources. Note that there are two tables for font 
resource defaults. Table A-6 shows the font defaults for an XIIR5 server, and Table A-7 shows the 
font defaults for a non-XIIR5 server (for example, XIIR4, OpenWindows). 

A-1 
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Table A-I. General Resource Defaults 

Resource Default Value 

Spv*fontList: variable 

Spv.Geometry: 600x350 

Spv*textForeground: black 

Spv*textBackground: white 

Table A-2. Keyboard Accelerator Defaults 

Resource Default Value 

Spv*file*open.accelerator: CtrkKey>O 

Spv*file*open.acceleratorText: Ctrl+O 

Spv*file*record.accelerator: CtrkKey>R 

Spv*file*record.acceleratorText: Ctrl+R 

Spv*file*save.accelerator: CtrkKey>S 

Spv*file*save.acceleratorText: Ctrl+S 

Spv*file*host.accelerator: CtrkKey>H 

Spv*file*host.acceleratorText: Ctrl+H 

Spv*file*exit.accelerator: CtrkKey>E 

Spv*file*exit.acceleratorText: Ctrl+E 

Spv*options *display .accelerator: CtrkKey>D 

Spv*options *display .acceleratorText: Ctrl+D 

Spv*options*utilization.accelerator: CtrkKey>U 

Spv*options*utilization.acceleratorText: Ctrl+U 

Spv*options *partitions.accelerator: CtrkKey>P 

Spv*options *partitions.acceleratorText: Ctrl+P 

Spv*options*colors.accelerator: CtrkKey>C 

Spv*options*colors.acceleratorText: Ctrl+C 
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Paragon™ System Performance Visualization Tool User's Guide Default SPV Configuration 

Table A-3. File Name Resource Defaults 

Resource Default Value 

Spv.fileName: N/A 

Spv.hostName: N/A 

Spv.helpFile: spv.hlp 

Table A-4. Display Option Resource Defaults 

Resource Default Value 

Spv.showUtilizationOf: cpu 

Spv.maxPageFaults: 100 

Spv.showUtilizationAs: current 

Spv.includeMsgPinCPUs: false 

Spv.computeCPUutilizationAs: average 

Spv.updateTime: 2 

Spv.zoomScale: 1.25 

Table A-5. Button Resource Defaults 

Resource Default Value 

Spv.button2: previous 

Spv. button3: utilization 
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Resource 

Spv*fontl: 

Spv*font2: 

Spv*font3: 

Spv*font4: 

Spv*font5: 

Spv*font6: 

Resource 

Spv*fontl: 

Spv*font2: 

Spv*font3: 

Spv*font4: 

Spv*font5: 

Spv*font6: 
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Table A-6. Font Resource Defaults (XllR5 Servers) 

Default Value 

-bitstream-charter-bold-r-normal--9-*-*-*-*-*-iso8859-1 

-bitstream-charter -bold-r-normal--l 0-*-* -*-* -*-iso8859-1 

-bitstream-charter-bold-r-normal--ll-*-*-*-*-*-iso8859-1 

-bitstream-charter-bold-r-normal--12-*-*-*-* -*-iso8 859-1 

-bitstream-charter-bold-r-normal--13-*-*-*-*-*-iso8859-1 

-bitstream-charter-bold-r-normal--14-*-* -*-* -*-iso8859-1 

Table A-7. Font Resource Defaults (Non-XllR5 Servers) 

Default Value 

-adobe-new century schoolbook-medium-r-normal-*-8-*-*-*-*-*-

-adobe-new century schoolbook-medium-r-normal-*-l0-*-*-*-*-*-

-adobe-new century schoolbook-medium-r-normal-*-12-*-*-*-*-*-

-adobe-new century schoolbook-medium-r-normal-*-14-*-*-*-*-*-

-adobe-new century schoolbook-medium-r-normal-*-18-*-*-*-*-*-

-adobe-new century schoolbook-medium-r-normal-*-24-*-*-*-*-*-
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Table A·S. Color Terminal Resource Defaults 

Resource Default Value 

Spv*foreground: white 

Spv*background: #165284 

Spv*alert_dialog.foreground: #165284 

Spv*alert_dialog.background: white 

Spv*selectColor: limegreen 

Spv.utilizationColors: 95.00 #BFOOOO 
90.00 #F95D42 
80.00 #ED9DOO 
70.00 #FFDlOO 
60.00 #FFFFOO 
50.00 #OOCD66 
35.00 #7FFFOO 
20.00 #00B2EE 
1.00 #OOFFFF 
0.01 #BOBOC8 
0.00 #FFFFFF 

Spv.utilizationStipples: N/A 

Spv.partitionColors: #8C8C8C 
IO #OOOOFF 
.service #FOE68C 
.compute #BBFFFF 

Spv.partitionStipples: IO largeLineHatch 
.compute largeLineDiagRight 
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Table A-9. Gray Scale Resource Defaults 

Resource Default Value 

Spv*foreground: black 

Spv*background: white 

Spv*alert_dialog.foreground: white 

Spv*alert_dialog.background: black 

Spv*selectColor: N/A 

Spv.utilizationColors: 95.00 #000000 
90.00 #000000 
80.00 #606060 
70.00 #808080 
60.00 #AOAOAO 
50.00 #404040 
35.00 #707070 
20.00 #7C7C7C 
1.00 #000000 
0.01 #000000 
0.00 #FFFFFF 

Spv.utilizationStipples: 95.00 solid 
90.00 dotsVeryDark 
80.00 solid 
70.00 solid 
60.00 solid 
50.00 lineDiagHatch 
35.00 lineHatch 
20.00 cross_weave 
1.00 dimple3 
0.01 boxes 
0.00 solid 

Spv.partitionColors: #FFFFFF 
10 #8A8A8A 
. service #ABABAB 
.compute #D4D4D4 

Spv.partitionStipples: solid 
10 boxes 
.service largeLineHatch 
.compute largeLineDiagRight 
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Table A-IO. Monochrome Resource Defaults 

Resource Default Value 

Spv*foreground: black 

Spv*background: white 

Spv*alert_dialog.foreground: white 

Spv*alert_dialog.background: black 

Spv*selectColor: N/A 

Spv.utilizationColors: 0.01 #000000 
0.00 #FFFFFF 

Spv.utilizationStipples: 95.00 solid 
90.00 dotsVeryDark 
80.00 dotsDark 
70.00 largeLineDiagHatch 
60.00 lineHatch 
50.00 lineDiagHatch 
35.00 cross_weave 
20.00 dimple 1 
1.00 dimple3 
0.01 boxes 
0.00 solid 

Spv.partitionColors: #FFFFFF 
10 #000000 
.service #000000 
.compute #000000 

Spv.partitionStipples: solid 
IO boxes 
.service largeLineHatch 
.compute dotsNorm 
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B 
basic displays 1-1 

best fit command 2-28 

blocking errors 1-12 

button resources 3-5 

c 
change color options command 2-24 

change data display options command 2-19 

collecting data 2-17 

colors 
selecting 2-22, 2-23, 2-24 

Index 

commands 
best fit 2-28 
change color options 2-24 
change data display options 2-19 
exit 2-17 
help 2-31 
host name 2-15 
index 2-30 
on context 2-30 
on display 2-32 
on invocation 2-32 
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on menu commands 2-32 
on overview 2-32 
on version 2-31 
on Xresources 2-32 
open playback 2-6 
previous zoom 2-29 
record data 2-10 
save options 2-16 
show partition color mappings 2-23 
show utilization color mappings 2-22 
zoom in 2-28 
zoom out 2-28 
zoom to CPUs 2-29 
zoom to mesh 2-29 
zoom to nodes 2-29 
zoom to value 2-29 

compute CPU 1-5 

configuring SPV 3-1 

context-sensitive help 2-30 
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CPU display 1-2 

CPU utilization 1-2, 1-6 

customer service vii 

D 
data collection 2-17 

data collection menu 2-17 

default resource settings A-1 

display 
CPU 1-2 
mesh 1-4 
node 1-6, 1-13 
values 1-5 

display area 2-4 

display option resources 3-2 

DISPLAY variable 1-9 

display window 2-1 
display area 2-4 
menus 2-2 
scroll bars 2-4 
size 1-2 
status line 2-3 
title bar 2-2 

displaying failing nodes 1-13 

displays 1-1 
zooming between 1-8 

E 
entering a host name 2-15 

error conditions 1-11 

errors 
blocking 1-12 
response 1-11 
socket 1-11 

exit command 2-17 
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F 
file menu 2-4 
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host name 2-15 
open playback 2-6 
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save options 2-16 
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files 
playback 2-6 
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Spv resource file 2-16 
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help command 2-31 

help menu 2-29 
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index command 2-30 

K 
keyboard accelerator resources 3-6 

M 
mapping partition colors 2-23 

mapping utilization values 2-22 

memory bus utilization 1-6 

menu bar 2-2 

menus 2-2 
data collection 2-17 
file 2-4 
help 2-29 
options 2-18 
zoom 2-27 

mesh display 1-4 

mesh utilization 1-4, 1-6 
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mouse buttons 
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Paragon front panel 2-1 

parameters 1-9 
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playback file 2-6 

previous zoom command 2-29 
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record file 2-10 
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resources v, 1-2, 1-11,2-16 
button 3-5 
defaults A-1 
display option 3-2 
file name 3-1 
font 3-4 
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utilization colors 3-2 

response errors 1-11 

s 
save options command 2-16 
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saving SPY data 2-10 
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setting DISPLAY variable 1-9 
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w 
window manager v 
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X resources v, 1-2 

xhost 1-9 
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zoom in command 2-28 
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